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Introduction 

There are five sections in StartUp:

Installation 
A stepbystep view that explains the installation process.

Configuration 
A summary of the system paths and the settings used for configuring Calamus.

Fundamentals 
An illustrated tour of the Calamus desktop and some standard elements.

Modules 
Highlights of the functions of all modules included with Calamus.

Quick Tour 
Loading and saving files; printing; handling frames, text and graphics; color tables, including a step-by-
step explanations of some basic functions.



Introduction

Welcome to StartUp. This guidebook covers some important elements to help learn Calamus for Windows 
NT. It is recommended that you take the time to browse through StartUp. If you like, you may defer 
reading of the Installation and Configuration sections to a later time since these functions are handled 
almost automatically by the Calamus installation program. On the other hand, Fundamentals, Modules 
and the Quick Tour are essential reading. By investing a little time in those sections, you will substantially 
reduce the learning curve. Similarly, working through the Practice Tutorial will accelerate your mastery of 
Calamus.

Note: Within StartUp you will find references to the Calamus Reference Manual. Refer to those sections 
for more detailed information about an item.



Quick Tour

Quick Tour illustrates some of the main operations in Calamus. 

This section will take you through the basic steps for loading and saving, printing, frame, text and 
graphics handling plus use of the Object Linking and Embedding module.

Loading a Document
Saving a Document 
Abandon Changes 
Printing a Document 

Calamus is a frameoriented desktop publishing system. Frames are created to hold text and graphic data 
that can be created on screen or imported from other sources. This section of the Tutorial deals with the 
creation and manipulation of frames.

Frames and Layout 

The next two sections deal with text and graphics.

Text 
Graphics 

And finally some tutorials:

Text Handling Tutorial 
Graphics Tutorial 



Abandon Changes

The Abandon Changes item in the File menu will abandon the current document and reload the last 
version that was saved. This function is used to restart work on a document before you have saved any 
changes.



Loading a Document

Calamus documents are saved as CDK files in the DOCUMENT subdirectory or whatever path you have 
chosen. To load a Calamus document, click Open Document in the File menu. You may open as many 
documents as your computer's memory can handle. The name of each open document is displayed at the 
bottom of the Window menu. If you have more than one document open, use either the Tile or Cascade 
item in the Window menu to arrange your document windows. Of course, working with too many open 
documents can be confusing.

Calamus File Selector 

The installation program copies sample files which can be retrieved for practicing. Click Open Document 
in the File menu. The Open Document file selector will appear. Select a sample document by clicking 
once on its filename and then clicking the OK button or quickly double-click the filename. Load several 
documents at one time by pressing the [Control] key while selecting each filename. When you click OK, 
all selected documents will be loaded. You can open as many documents as your RAM allows. 

 If you loaded several sample documents, each would occupy its own document window. To view a 
particular document, click the Window menu and click the filename. The selected document window will 
be displayed in front of any other open documents. If you want to view all open documents at the same 
time, use the Tile or Cascade functions in the Window menu. 

In addition to loading documents, you may also load fonts, import and export drivers, text style lists, color 
lists and master pages. These elements are loaded in a Calamus object selector which is described in 
Standard Elements, chapter 1. You may also save those elements as part of the CALAMUS.SET file so 
that they are automatically loaded when you launch Calamus.



Saving a Document

There are several options for saving documents in Calamus: 

Save Document 
Save Document As... 
Save All Documents. 

In addition to the three methods described above, there are other options for saving documents. When 
you click Close Document in the File menu, you are prompted to Save or Abandon the current document. 
Save will use the current filename and save the document. Abandon will close the document without 
saving any changes made since the last time the document was saved.

When you click Exit in the File menu, the Exit Calamus alert will prompt you to save any open documents. 
Those which were previously saved will be saved with the same filenames before Calamus is closed.

You can also save your open documents automatically while you work. In the Miscellaneous Settings 
dialog box (Options menu) you can choose an interval for autosaving. It is also advisable that you use the 
Save ... Backup option. As with the other save options, any new documents will have to be named before 
they are saved the first time. It is recommended that you use the backup option in the Miscellaneous 
Settings dialog box to keep a BAK copy of each document. BAK files may be loaded in the same way as 
CDK files.

Finally, the Abandon Changes function (File menu) will restore a document to its last saved version while 
abandoning any changes made in the interim.



Save Document

Much of the time, you will use Save Document. If your document has been saved previously, the Save 
Document function will work quickly and no dialog box will appear. If you have created a new document, it 
must be given a filename the first time you save it. The Save Document As... object selector will prompt 
you for a filename.



Auto Save Document

Calamus also have an AutoSave feature that will save all open documents at selected time intervals. 
Autosaving is useful for those who might forget to save their work at regular intervals. The first save must 
be done manually; following the first save, autosave will occur at the specified intervals.



Save Document As... 

If you want to save a document with a different name, use Save Document As... to enter your new 
filename. Place the cursor on the Selection line and type the filename you wish to use to save a 
document then click the OK button to complete the save.



Save All Documents. 

If you have several documents open at the same time, you can use Save All Documents to save them all 
at the same time. If any of the documents were not previously saved, you will be prompted to enter a 
filename.



Printing a Document

The print functions in Calamus depend on the Windows Print Manager to set the default printer driver. If 
required, consult your Windows manual to install printer drivers. You can also switch to any other printer 
driver that is loaded in the Print Manager from the Printer Settings dialog box.

Print/Printer Settings Dialog Box 

The selected printer driver provides information about page size and the printable area for the selected 
printer. If the guideline display is enabled in the Frame module, the document page will show the printable 
area as light gray dashed line around the edge of the page.

The printable area information is also used by the tiling functions in the Frame module to determine the 
size of each printing tile. As shown in the Automatic Tiling dialog box, the printable area is used to 
calculate the number of tiles needed to print a page, or a range of pages. See Tiling functions in the 
Frame module, chapter 5, for more information.

Print Document 



Print Document

To print a document, select Print Document in the File menu. The Printer Settings dialog box will appear. 
There are four sections, called "tab dialogs" in the Printer Settings dialog box. Each is accessed by 
clicking the tab button on the left side of the dialog box.

The top section displays information about the current printer driver. Click the down arrow to the right to 
show all available printer drivers loaded in the Print Manager. 

In the illustration you can see three drivers. The HP500 and LJ4 are loaded in the Print Manager while the 
Ultre is a special driver module loaded in the Modules dialog box. There are other special printer drivers 
such as the TIFF.CXM, BMP.CXM and DCS.CXM for printing TIF, BMP and DCS files, respectively, to 
disk. See Appendix H in the manual for details.

The next part of the Printer Settings dialog lets you select the options available for the current printer 
driver. The Form dropdown list allows the selection of different paper and envelope sizes; the Resolution 
field allows the selection of the available printing resolutions; the Tray field allows the selection of paper 
feed options; and the Color Depth field allows the selection of color and monochrome formats for the 
printer driver. The default settings are the ones you would normally use.

For more information, please select any of the following choices.

Printing in General 

Print - Document Tab 
Print - Options Tab 
Print - Advanced Tab 
Print - Color Tab 



Print - Document Tab

Print/Printer Settings Dialog Box 

The options in the Document tab dialog box are:

Print - Copies 
Print - Scaling 
Print - Fit to Page 
Print - All 
Print - Select
Print - Orientation



Print - Options Tab

The options in the Options tab dialog box are:

Print - Sort
Print - Tiling
Print - Duplex
Print - TrueType Fonts
Print - Collate Copies



Print - Advanced Tab

The options in the Advanced tab dialog box are:

Print - Options
Print - Pattern
Print - Layout Elements
Print - Use Softripping
Print - Use Generic Windows



Print - Color Tab

The options in the Color tab dialog box are:

Print - Single Plane
Print - Color Separation (CYMK)
Print - Overprint Black
Print - Printing to a File



Frames and Layout

Calamus is a frameoriented desktop publishing system. Frames are created to hold text and graphic data 
that can be created on screen or imported from other sources. This section of the Tutorial deals with the 
creation and manipulation of frames.

The six kinds of frames that hold data are illustrated below:

Frame Data

For information on other aspects of frame handling, click on the appropriate subject below:

Creating Frames 
Modifying Frames 
Moving Frames 
Copies - Physical and Virtual 
Coordinate Display 
Sizing Frames 
Guidelines 
Magnetic Frames 
Frame Alignment 

Toolbox Module 
Masking 
Master Pages 



Copies - Physical and Virtual

Frames may be physical or virtual copies of an original frame. If a frame is a virtual copy of another frame, 
whatever change is made to it can be made to the copy at the same time. As soon as a command icon is 
clicked after a virtuallycopied frame is selected, the following alert appears:

Click This One to restrict an operation to the selected frame; click All to effect the change on all virtual 
copies of the frame, including those inside a group frame. If you do select This One, the frame becomes a 
physical copy, and is unlinked from the virtual copies to which it was originally connected. 

Frames can be linked another way, Click Dynamic Linking to read more.

Dynamic Linking 



Frame Alignment

It is possible to draw or align frames along nonprinting lines which may appear as a grid or as a set of 
guidelines. Setting up grids and guidelines is described in the Frame Module, chapter 5.

Frames may be horizontally and/or vertically "snapped" to grid and guidelines. The snap functions are 
activated by clicking the respective command icons in the Guidelines command group of the Frame 
module.

You can also align frames according to other frames. One method is to use the Magnetic Frames function 
described in chapter 5, Guidelines command group of the Frame module.

Another method for aligning frames is to use the functions in the Toolbox module. The Toolbox functions 
are particularly useful for axis and edge alignment of frames. See    Toolbox Module, chapter 5.

After you have arranged frames in relation to each other, you may want to lock them together. This is 
called "grouping". Frames that are grouped may still be manipulated in a number of ways: e.g. rotation, 
mirroring, resizing and moving. Some functionalitys are not present in group frames: text cannot be edited 
if a text frame is in a group; colors may not be changed in raster areas. However, if a virtual copy of a 
frame exists outside the group frame, it is possible to change a frame's contents by changing the virtual 
copy.



Creating Frames

In the Tools command group of the Frame module, select the type of frame to be drawn. Next, click the 
Create Frame icon to change the pointer to the arrowshaped Create Frame pointer. 

Click the left mouse button once to change the pointer to the Cross Hair. The point at which you clicked 
will be the top left corner of the frame. Move the pointer to the end position and click a second time to set 
the bottom right corner of the frame. The empty frame will appear on screen.



Modifying Frames

Once created, a frame may be modified by changing its location or size. To modify a frame, click the 
Modify Frame icon in the Frame module's Tools Command Group. You can also switch to modify mode by 
clicking the right mouse button. The mouse pointer will change to the finger shape.

In order to modify a frame, you must first select it. This is done by clicking once inside a frame. Four or 
eight sizing handles will appear around the edge of the frame. The frame is now ready to move or resize.



Moving Frames

To manually move a frame, click once in the frame to select it. Click a second time and hold down the left 
mouse button. The pointer will change to an open hand shape. While keeping the mouse button pressed, 
move the mouse pointer and an outline of the frame will follow. Release the mouse button when you have 
placed the frame in the desired location. To abort, click the right mouse button before releasing the left 
button; the frame will return to its original position.



Coordinate Display

To move or resize a frame, you can use the mouse pointer or the Coordinate Display. To move a frame 
with the mouse pointer, select the frame by clicking on it once. The frame handles will appear darker. With 
the mouse pointer on the selected frame, click and hold down the left button; it will change to a hand 
shape. Without releasing the mouse button, move the hand to another location and the frame will move 
with it.

Coordinate Display - Sizing

To use the Coordinate Display to move a frame, select the frame with one click of the left mouse button. 
Click the Coordinate Display in the Toolbar. The following input fields will appear:

Enter values for X and Y and press the [Enter] key. The selected frame will move to the position entered. 
X and Y positions are calculated according to the page origin. By default, the origin is the topleft corner of 
the page. However, a different page origin may be set in the Page Layout Settings dialog box in the Page 
module.

To resize a frame while maintaining the height to width ratio, select Proportional Sizing in the Tools 
command group of the Frame module.

Click the mouse pointer on any frame handle and drag the handle to a new location. An outline of the 
frame will expand in the direction of the mouse pointer. Click the mouse button a second time to set the 
frame handle and complete the resizing of the frame. To abort, click the right mouse button before you 
click the left one.

You can also use the Coordinate Display to resize a frame. As noted above, select Proportional Sizing to 
maintain the height to width ratio of the frame if you wish. Select a frame with one mouse click; then click 
the Coordinate Display in the Toolbar. Enter a new width in the dX field or a new height in the dY field. If 
you selected Proportional Sizing, you only need to enter dX or dY; the other value is set automatically.

A quick way to reduce or enlarge frame size is to enter a percentage in the dX or dY field. The selected 
frame will be resized exactly to the specified percentage.



Sizing Frames

All Calamus frame types contain sizing handles. If Proportional Sizing is selected in the Frame module, 
there will be four sizing handles on a frame: one in each corner. If Proportional Sizing is not selected, 
there will be eight sizing handles: one in each corner and one at the midpoint of each side of the frame.

When Proportional Sizing is selected, the heighttowidth ratio of a frame is maintained when you resize it. 
To manually resize a frame, switch to modify mode, then click and drag a sizing handle using the mouse 
pointer. The pointer will change to a cross hair and outline of the frame will follow the cross hair as you 
move it. 

Click the left mouse button a second time to complete the resizing of the frame. To abort resizing, click the 
right mouse button.

Note: With one exception, you must be in Modify Frame mode to resize a frame. To enter frame 
mode, click the Frame module icon in the Module Row. The mouse pointer will change to the finger 
shape. If you are in text mode, you can resize a text frame by clicking and dragging the Ibeam text cursor 
on a frame sizing handle.

The Coordinate Display can also be used to resize a frame. Select a frame and click the Coordinate 
Display. Enter a new value or a percentage in the dX field to change the width of a frame; enter a new 
value or a percentage in the dY field to change the height.



Guidelines

Guidelines are very helpful for placing frames on the layout page. The Set Columns and Rows function is 
create guidelines that help to layout frames in a symmetrical manner. You can create guidelines based on 
a matrix of columns and rows with definable spacing between them as well as Top, Bottom, Left and Right 
margin areas. The guidelines created in this function can be applied to any page size or format. 
Guidelines are saved with your document and may be saved in individual master pages.

For other jobs you may choose to set guidelines in a freehand manner. Select the vertical or horizontal 
guideline icon and click in the document window to place guidelines. 

Set Columns and Rows Dialog BoxSet_Columns_and_Rows_Dialog_Box 

To move a guideline, click the respective Move Guideline icon and then click and drag the desired 
guideline to a new position. For precise positioning, press the [Shift] key when you click on a guideline. 
The Guideline Placement alert will let you input precise coordinates.

Click the eraser icon and then click on any guideline you wish to remove.

Click the Delete All Guidelines icon to remove all guidelines placed by freehand.



Magnetic Frames

Set Grid, Layout Ruler and Magnetic Frames Dialog Box

Magnetic frames let you position frames at a userdefined distance from other frames. First, set the 
magnetic frame "border" in the Set Grid, Layout Rulers and Magnetic Frames dialog box.

Click the Magnetic Horizontal Frame and Magnetic Vertical Frame icons in the Frame module Guidelines 
Command Group. All frames will snap to other frames at the distance set in the dialog box.

To display the magnetic frame border associated with each frame, click the Show Magnetic Border icon in 
the Frame Display Command Group.



Toolbox Module

The Toolbox module provides additional methods to align frames to other frames. You can align frames 
according to any edge, or according to the horizontal or vertical axis. You can even align frames 
according to their centerpoints.

To align two or more frames, select the frames and then click the icon for the desired type of alignment.

Another feature in the Toolbox Module is its ability to convert frame types from one to another. Click below 
to read more.

Converting Frames 



Text

This section of the Tutorial will cover text entry and editing plus an overview of the Text Style functions. 
Text entry will deal with both the creation and editing of text in text frames. Text styles will explore the 
functions for creating and editing text styles.

Text Entry Methods 
Text Flow 
Text Editor 
Drag and Drop 
Text Styles 



Text Entry Methods

The simplest way to create text is to draw a text frame and begin typing letters into it. This method is quite 
suitable for designing flyers, notices, newsletters and other projects that may not need a lot of keyboard 
typing. The advantage of direct entry of text into text frames is that you can see exactly how the finished 
project looks as you work. The disadvantage is the slower speed at which you can type compared to 
using a wordprocessor or text editor, caused by the constant WYSIWYG screen refresh of text in a text 
frame as you enter each letter. 

For larger projects such as a novel, manual or lengthy article, it is more likely that text will be created in a 
wordprocessor and then imported into text frames. The advantage is one of speed, plus the added 
features that are found in many wordprocessors. In addition, text effects such as bold, italics and 
underline are retained when the wordprocessor file is imported by using the appropriate text import driver.

Calamus also has an internal text editor that allows block functions and search and replace as well as 
basic text editing. In addition to being faster than typing text into a text frame, the internal text editor also 
lets you insert and edit layout control codes that affect the text styles and paragraph formatting. These are 
features that are not found in wordprocessing programs.

Direct Text Entry 
Importing Text 



Direct Text Entry

In order to create a text frame into which you can type text, you must first load a font in the Font Selection 
command group of the Text Style module. After drawing a text frame, enter text mode by clicking the Text 
module icon in the Module Row. If the text frame is not selected, click in it once and a flashing Ibeam 
cursor will appear in the top left corner. 

Type the required text; it will appear in the text frame using the font and size currently selected in the Text 
Style module. As you enter text, all the text in the frame is reformatted with each few letters you type. As 
the amount of text increases, it will take longer for each refresh of the page.



Importing Text

To import text, select a text frame and then click Import in the File menu. The Import Text object selector 
will appear. Load the driver for the type of wordprocessor file that you wish to import. 

The table of import drivers shows which wordprocessors are supported.

Format Driver 

ASCII ASCII.CXT
Lotus AmiPro 3.0 AMI.CIT
Rich Text Format RTF.CXT
Word for Windows 2.0 WORD.CIT
WordPerfect 5.0/ 5.1 WP.CIT
Write for Windows WRITE.CIT

The imported text will be formatted in the selected text frame or text piping chain in the font and size that 
are currently selected in the Text Style module. It is therefore suggested that a suitable font and size be 
selected before importing a text file.

Import Text Dialog Box

Special attributes in the original wordprocessor file, such as bold, italic and underline, will be retained in 
the imported text through the creation of internal text styles. This feature is explained in the Text Style 
section of the Tutorial.

Importing Text Tutorial 



Importing Text Tutorial

To import text into a selected text frame, click Import in the File menu. The Import Text selector will appear 
with several import drivers already loaded: 

Click the import driver for the type of file you wish to import; if the driver is not loaded, click the Load 
button and select the required driver when the file selector appears. (The Installation program has preset 
the path to the Calamus drivers.)

Click the Import button and the file selector appears. Locate the path and filename for the text file you 
wish to import. Select the file by clicking its filename, then click OK. The text of the imported file will be 
formatted in the selected text frame. 

If there is too much text for the selected text frame, the overflow icon will appear in the bottom right corner 
of the frame. If there is only a little text left to display, try resizing the text frame. If a lot of text is left, you 
will have to create an additional text frame and link it to the first frame. 

Draw a second text frame; select the original text frame; click the Piping from Frame to Frame icon in the 
Text Special Functions command group of the Frame module; and click the second text frame. The 
leftover text will be flow into the new frame.



Text Flow 

It is possible that more than one text frame is needed to hold text. The text piping functions let you flow 
text from one text frame to another. Text frames may be on the same page or on different pages. 

To pipe text between two frames, select the first frame and click the Piping from Frame to Frame icon in 
the Text Frame Special Functions command group; then click the second text frame. Excess text from the 
first frame will flow into the second frame as you type or when you import a text file.

You can also create a series of piped texts on consecutive pages by clicking the Piping from Previous 
Page and Piping to Next Page icons after selecting a text frame.    Hint: create a text frame on one page, 
click the Piping from Previous Page and Piping to Next Page icons; then click Insert Empty Pages (Page 
module) and use the Copy Layout function. A series of pages with piped text frames will be ready to 
accept imported text. Text will automatically flow through the entire text chain when you import.

If there is too much text for a text frame, the Overflow icon will appear when you point to the frame. 
Similarly, if there is no text in a text frame which is part of a text piping chain, the Insufficient Text icon will 
appear when you point to the text frame.



Text Editor

The Calamus Text Editor lets you create or edit text that can be transferred quickly to a text frame. To 
send text from a frame to the text editor, select a text frame and click the Open Text Editor icon in the 
Tools command group of the Text module. All text in the selected text frame or text piping chain will be 
imported into the text editor.

The text editor contains menus and a toolbar like most Windows applications. 

Calamus Text Editor Dialog Box

The Calamus Text Editor uses standard Windows conventions for editing and selecting text: 

[Down Arrow] Next line
[Up Arrow] Previous line
[End] End of line
[Home] Beginning of line
[Page Down] Next screen
[Page Up] Previous screen
[Control]+[Right Arrow] Next word
[Control]+[Left Arrow] Previous word
[Control]+[End] End of text
[Control]+[Home] Beginning of text

[Backspace] Erase letters to left of the cursor
[Delete] Erase letters to right of the cursor

[Shift]+[Down Arrow] Select next line
[Shift]+[Up Arrow] Select previous line
[Shift]+[Left or Right Arrow] Select individual letters
[Shift]+[Control]+[Right Arrow] Select next word
[Shift]+[Control]+[Left    Arrow] Select previous word
[Shift]+[Control]+[Shift]+[Home] Select all text to beginning 
[Shift]+[Control]+[Shift]+[End] Select all text to end

Search and Replace 
Control Codes 
Send Editor Text into Text Frame 



Drag and Drop

You can move selected text using Drag and Drop in either the text editor or right in a text frame. Select 
the text to be moved by using the keyboard conventions or by dragging the mouse pointer over the text. 
Once the text is selected, click and hold the left mouse button while you move the mouse pointer to the 
point where you want to insert the selected text. Release the mouse button and the text will be moved to 
the insertion point. To abort drag and drop, click the right mouse button before releasing the left mouse 
button.



Search and Replace

The text editor also contains a Search and Replace function that can be used for both text and layout 
control codes. 



Control Codes

Layout control codes can be inserted and edited in the text editor. This provides the ability to create and 
edit text rulers that affect text formatting, style codes that include font and text attribute information, and 
special text codes for page and chapter numbers, index and footnote entries, date and time stamps and 
kerning information.

Control codes can be accessed in a number of ways. The Insert menu provides entry for text styles, 
layout control codes, text rulers and text macros. 

The toolbar contains icons for text styles, text rulers and layout control codes.

You can also access control codes by using the popup menu. Just click the right mouse button inside the 
text editor. When the popup menu appears, use the cursor keys to select the required control code and 
press [Enter]. For some control codes, a dialog box will appear for you to enter a setting such as a 
chapter number, kerning value, index entry or comment. Then the respective control code will be 
embedded in the text passage.



Send Editor Text into Text Frame

When you are finished working in the Calamus Text Editor, you will need to send the text from the editor 
into a selected text frame. There are several ways to do this. The first method is to click the left typewriter 
icon in the toolbar. The following dialog box appears:

Send Editor Text into Text Frame Dialog Box

Add will send the text in the text editor to the end of the text piping chain in the selected frame. Replace 
will overwrite the text in the text chain with the text being sent from the editor. Merge will insert the text in 
the editor at the cursor point in the text frame. Block will replace a selected text block (if one was marked) 
with the text from the text editor. Cancel will return you to the Text Editor.

You can also click Exit in the File menu to call the Send Text into Text Frame dialog box with the same 
options as shown above.

If you wish to close the text editor without sending text into a text frame, select Abort in the File menu and 
click No when asked if you wish to Save the edited text? The text editor will close and all text in it will be 
erased.



Text Styles

This section of the Tutorial covers the creation and editing of text styles. Text styles are the characteristics 
applied to text in your document. Such characteristics include the choice of font, size, color and fill pattern 
and various text effects (underline, outline, shadow, compression, skewed text, subscript and superscript).

Text styles may be created as either "internal" or "list". A list text style is one whose name appears in the 
Text Style List command group whether or not it is use in a document. An internal text style has two 
arrows before its name in the Text Style List command group. Internal text styles may be hidden from 
view if the text style list becomes too full.

Text styles are easily created by clicking icons in the various command groups of the Text Style module or 
by working inside the Edit Text Style dialog box. You can also change the attributes of any text style. The 
new attributes are automatically applied to all text to which the text style has been applied. These 
techniques are described within each Text Style command group.

Text Style Lists can also be saved and loaded into other documents. This is useful for ensuring 
consistency from one document to another. You can also save a particular Text Style List in your system 
setup file so that it loads whenever you launch Calamus.

Applying a Text Style 
Creating a Text Style 
Font Selection 
Font Size 
Text Effects 
Text Attributes 
Underline 
Outline 
Shadow 
Text Style List 



Applying a Text Style

There are two basic ways to apply a text style to text. The first way is to click on a text style name in the 
Text Style List command group. The text style may be either an internal or list type of text style. If a block 
of text is marked, the text style will be applied to the text immediately. If no text block is marked, an alert 
prompts you to apply the text style to the entire text piping chain. If you click the "Yes" button, all text will 
be changed to the selected text style.

The second way to apply a text style is to click the Change Text Style icon which is found at the bottom of 
several command groups in the Text Style module. When using this method, the current selections in all 
command groups are used to create an internal text style which is then applied to any marked text or to a 
complete text piping chain if no text is marked.



Creating a Text Style

To create a text style, a font must be loaded. If you are using DMC typesetter fonts in CFN format, the 
Font Loader module must be loaded. TrueType fonts in TTF format do not require the Font Loader 
module.

To load a font, click the Load Font icon in the Font Selection command group of the Text Style module. 
The Load Font object selector will appear. Click the Load button and the file selector will appear. Select 
the correct path and filename for the font you wish to load. 

The font name will then appear in the Load Font object selector box and in the Font Name List of the Font 
Selection command group. Load as many fonts as you need; use the scroll bars to view hidden font 
names. 

Load Font Dialog Box



Font Selection

To select a font, click once on its name in the Font Selection command group. Click the Change Text Style 
icon to apply the font to the selected text or piping chain. An internal text style will also appear in the Text 
Style List.



Font Size

The Font Size command group contains 14 preset sizes and an edit field where you can enter a custom 
size. This command group also provides a choice of three systems for measuring font height: EmHeight, 
Versal Height and Designer Height. Select the font size and measurement system you wish and click the 
Change Text Style icon. The marked text or piping chain will be changed to the currently selected font and 
size. An internal text style will also appear in the Text Style List.



Text Effects

The Text Effects command group provides choices for the various effects: Underlined, Shadowed, 
Superscript, Subscript, Compressed and Skewed. To select one or more text effects, click the button to 
the left of the text effect name.    The first four text effects are self-explanatory. The Compressed text 
effect may be used to make text narrower or wider than normal. This is done by entering a percentage 
value in the compressed text input field.

Similarly, skewed text may be slanted to any angle from positive to negative 45 degrees by entering the 
desired angle in the skewed text input field.

In addition to the text effects in the list, you can also control the proportional spacing between characters 
by selecting or deselecting Proportional Spacing and Automatic Kerning icons at the bottom of the 
command group. 

The Numeric Table Mode lets you have proportional spacing for letters but monospacing for numbers 
within the same text style. This feature is useful for aligning tables of numbers.

Select the text effects you want to use and click the Change Text Style icon to apply them to the selected 
text or piping chain in the currently selected font and size. An internal text style will also appear in the Text 
Style List.



Text Attributes

The Text Attributes command group lets you select the color and fill pattern for text. You can also define 
the minimum spacing between individual characters and between words. The color list in the Text 
Attributes command group is the standard Calamus color list. You can load and save color lists by using 
the Color Settings module.

Select the text attributes you want to use and click the Change Text Style icon to apply them to the 
selected text or piping chain in the currently selected font and size. An internal text style will also appear 
in the Text Style List.



Underline

The Underline command group lets you select the color, weight, offset and overhang for an underline. The 
color list in the Underline command group is the standard Calamus color list. You can load a save color 
lists by using the Color Settings module.

The underline weight, offset and overhang can be specified as a percentage of the font size or as an 
absolute measure in the unit of measure chosen in the Set Units of Measure function of the Page module. 
Click the text label to the right of the number input field to toggle between percentage and a unit of 
measure.

To apply an underline to text, select the settings you wish to use and then select Underline in the Text 
Effects command group. Click the Change Text Style icon to apply the underline text style to the selected 
text or piping chain. An internal text style will also appear in the Text Style List.



Outline

The Outline command group lets you select the color and weight of a text outline. The color list in the 
Outline command group is the standard Calamus color list. You can load a save color lists by using the 
Color Settings module.

The outline weight can be specified as a percentage of the font size or as an absolute measure in the unit 
of measure chosen in the Set Units of Measure function of the Page module. Click the text label to the 
right of the number input field to toggle between percentage and a unit of measure.

To apply an outline to text, select the color and settings you wish to use and then select Outline in the Text 
Effects command group. Click the Change Text Style icon to apply the outline text style to the selected 
text or piping chain. An internal text style will also appear in the Text Style List.



Shadow

The Shadow command group lets you select the color and offset of a text shadow.The color list in the 
Shadow command group is the standard Calamus color list. You can load a save color lists by using the 
Color Settings module.

The shadow offset can be specified as a percentage of the font size or as an absolute measure in the unit 
of measure chosen in the Set Units of Measure function of the Page module. Click the text label to the 
right of the number input field to toggle between percentage and a unit of measure.

The shadow direction can be selected by clicking one of the nine boxes at the bottom of the command 
group. If the center box is selected, the text shadow will appear directly behind the text with no offset.

To apply a shadow to text, select the color and settings you wish to use and then select Shadowed in the 
Text Effects command group. Click the Change Text Style icon to apply the text shadow text style to the 
selected text or piping chain. An internal text style will also appear in the Text Style List.



Text Style List

The Text Style List command group contains the names of all internal and list text styles for the current 
document. To use a text style in the Text Style List, click a text style name in the list. The selected text 
style list will be applied to marked text or a complete piping chain. If there are more than 18 text styles in 
the list, use the scrollbar to view the other text styles.

To save the current text style list, click the Save Text Style List icon and enter a filename with a CSL 
extension when the file selector appears. 

To load a text style list or merge another list with the current list, click the Load Text Style List icon and 
select a filename when the file selector appears.

To add a new text style to the Text Style List, select the settings you wish to use in each of the other 
command groups of the Text Style module. Then click the Add Text Style to List icon and the selected 
settings will be used to create a new text style in the list.

Note: a new text style is also added to the text style list whenever you click the Change Text Style icon in 
the other command groups of the Text Style module.

Text Style List Parameters 
Change Text Style Settings 



Text Style List Parameters

The Text Style List Parameters Dialog Box

The Text Style List Parameters dialog box lets you choose to show both internal and list text styles, or just 
list text styles. The bottom half of the dialog box affects the way new text styles are created. If both 
buttons are selected, then new text styles can be created as either Internal or List text styles. If the 
Internal button is not selected, then new text styles will automatically be created as List text styles.



Change Text Style Settings

The Change Text Style Settings function lets you change one or more attributes of an Internal or List text 
style in the Text Style List. Click the Change Text Style Settings icon and then click the name of the text 
style which you want to change. The Edit Text Style dialog box appears.

Edit Text Style Dialog Box

The settings in the Edit Text Style dialog box correspond to each of the Text Style command groups. 
Change any settings for the currently selected text style. If you wish, you can select other text styles and 
change their settings before exiting the dialog box. When you click the OK button, the new settings are 
applied to all text to which the text style(s) were applied.

You can also create New text styles in the Edit Text Style dialog box. Select the settings for the new text 
style and click the New button. The font name, size and text effects settings will be used to create a text 
style name. If you wish, you can edit the text style name to another name.

Note: you can also access the Edit Text Style dialog box while working in the Text Editor. Click the [s] or 
[Text Style] control code for the text style you want to change. When the Edit Text Style dialog box 
appears, change the text style settings or create a new text style if you wish.



Graphics

Calamus supports a number of bitmap and vector graphic formats through import drivers. In addition, 
graphics may also be imported into a Calamus document from any application supporting Object Linking 
and Embedding. Click on any of the following options for additional information.

Bitmap Graphics 
Vector Graphics 

Importing a Graphic 
Optimizing a Graphic 
Resizing a Graphic 
Converting Frames to Bitmap Graphics 
Converting Color Depth of Bitmap Graphics 



Bitmap Graphics

Bitmap graphics are composed of color pixels that are created in a drawing program or by scanning a 
picture or photograph. The following bitmap formats are supported: BMP, IMG, PCX, GIF, TIF, JPG, MAC, 
TGA, SCT, and PCD.



Vector Graphics

Vector graphics are composed of points, lines and fill patterns. Supported formats include WMF, PLT and 
CVG (Calamus Vector Graphic). In addition, EPS files may be imported by using the special EPS Handler 
module.



Importing a Graphic

To import a graphic, you must first draw a raster graphic frame to import a bitmap or a vector graphic 
frame to import a vector graphic. Select the appropriate icon in the Frame Tools command group. Draw a 
frame and click Import in the File menu. An object selector dialog box will appear. Load an import driver 
for the type of graphic you wish to import and then click the Import button. When the file selector appears, 
click the filename of the graphic you wish to import. It will fill the frame which you drew.



Optimizing a Graphic

When you import a graphic into a graphic frame, it may appear distorted. This happens because the 
heighttowidth dimensions of the frame do not match those of the original graphic. One dimension or the 
other is distorted to fit the frame into which the graphic was imported. In order to restore the graphic to its 
correct proportions, it must be optimized. Calamus offers two methods for optimized a bitmap graphic; 
and one method for optimizing a vector graphic. 

Optimizing a Bitmap Graphic 
Optimizing a Vector Graphic 



Optimizing a Bitmap Graphic

Select the bitmap graphic and click the Optimize to Screen icon in the Raster Graphic Special Functions 
command group. The graphic frame will be resized to the original proportions and each pixel in the 
graphic will be mapped to one pixel on screen. You can also choose to Optimize to Printer. In this case, 
each pixel in the graphic is mapped in a manner that matches the resolution of your currently selected 
printer. If the printer's resolution is greater than that of the screen, the graphic will appear smaller than 
when Optimized to Screen.



Optimizing a Vector Graphic

To optimize a vector graphic, select the graphic frame and click Ideal Size in the Vector Graphic Special 
Functions command group in the Frame module. The vector graphic frame will be resized to an ideal size 
that restores the heighttowidth ratio of the original graphic.

Unlike bitmap graphics, a vector graphic is composed of lines, points and fills. In essence, these 
components form a set of instructions for drawing the graphic. As such, a vector graphic can be resized 
without encountering aliasing along curved edges or moiré patterns in fill patterns since these 
components are recalculated each time a vector graphic frame is resized.



Resizing a Graphic

Both bitmap and vector graphics can be resized by dragging the frame sizing handles to shrink or reduce 
the graphic frame. Select the frame and click on a frame sizing handle. Move the mouse pointer towards 
the middle of the frame to shrink it; move away to enlarge the frame. Frames may be resized horizontally, 
vertically or diagonally by dragging the side, top or corner frame sizing handles, respectively.

In order to retain the proper heighttowidth ratio of a graphic, first use the Optimize (bitmap graphics) or 
Ideal Size (vector graphics) functions. Then activate Proportional Sizing for the graphics frame by clicking 
the Proportional Sizing icon in the Frame Tools command group. The graphics frame will have four frame 
sizing handles; drag any one of them to resize a graphic while retaining the optimized heighttowidth ratio.

You can also use the Coordinate Display to resize a graphics frame. Select a frame and click the 
Coordinate Display in the Toolbar. Enter a new value in the dX or dY fields to change the width or height 
of the frame, respectively. 

You may also enter a percentage rather than a specific value. If the frame is in Proportional Sizing mode, 
entering either the dX or dY value will automatically calculate the corresponding value for the width or 
height of the frame.



Converting Frames to Bitmap Graphics

It is possible to convert any type of frame to a bitmap graphic frame by using the Toolbox module. Select 
the frame to be converted and click the Convert to Bitmap Frame icon in the Convert Frame    command 
group of the Toolbox module. The Convert to Bitmap Frame dialog box will appear. Set the resolution for 
the converted frame; it is usually best to use the same resolution at which the document will be printed. 
Then select the color format for the converted frame. The Memory Usage indicator shows the resulting 
amount of storage space required for the converted frame. 

Convert to Bitmap Frame Dialog Box

The Memory Usage is greater for color images than grayscale. Similarly, grayscale images require more 
memory than monochrome. Finally, the Memory Usage rises in proportion to the resolution selected.



Converting Color Depth of Bitmap Graphics

It is possible to reduce the color depth of a bitmap graphic using the functions provided in the Raster 
Graphic Special Functions command group of the Frame module. Color graphics may be converted to 
grayscale or monochrome while grayscale graphics may only be converted to monochrome. It is not 
possible to convert a graphic to higher color depth. For example, you cannot convert monochrome to 
grayscale or color, nor grayscale to color. 

Select the graphic frame to be converted and click the icon of color depth to which you wish to convert the 
frame. The Possible Loss of Data alert appears to warn you that some color information will be lost. If you 
may need to recover the original frame, experiment on a copy of the frame or keep a backup copy on the 
clipboard.



Print - Copies

Input the number of copies you wish to print.



Print - Scaling

Print your document smaller or larger than actual size.



Print - Fit to Page

Automatically scale your document to print as large as the page.



Print - All

Print all pages in the document.



Print - Select

Print the pages indicated in the From and To fields. Click the Select button to select the current document 
page.



Print - Orientation

Print pages in Portrait or Landscape mode or have Calamus automatically select the best mode based on 
the page setup.



Print - Sort

Up will print pages from first to last. Down will print the last page first.    Left and Right refer to the left and 
right hand pages in a facing pages document



Print - Tiling

Whole will print pages without tiling. All Tiles prints only tiled frames. Selected Tiles prints only those tiles 
which are selected when Print Document is selected in the File menu.



Print - Duplex

Horizontal and Vertical will print document pages on both sides of the page using a printer that supports 
duplex printing.



Print - True Type Fonts

This option lets you choose the method for printing TrueType fonts.



Print - Collate Copies

When selected, this option will print a full set of pages in the selected Sort order before printing the next 
copy.



Print - Options

Print pages in Inverse or Mirror mode. Select Layout to print page border elements such as crop marks, 
registration marks, color plane names and text labels.



Print - Pattern

The default of 1 is used to print fill patterns in their original 300 dpi resolution. Use N for a resolution that 
is a multiple of 300 (600, 1200, 2400). Use R for output resolutions that are not multiples of 300.



Print - Layout Elements

Takes you to the Page Layout Settings dialog box where you can edit the page border elements.



Print - Use Softripping

When printing on a PostScript device, softripping converts all data to bitmap images for printing. Output 
will be identical to screen display as large amounts of data are transferred to the printer.



Print - Use Generic Windows

The generic Windows printer driver can be used to bypass the internal rasterization process by using the 
Windows printer driver.



Print - Single Plane

This will convert all color planes to grayscale.



Print - Color Separation (CYMK)

The Color Separation module works with this option to separate and print each of the four process colors 
on its own page. Any spot colors will also be printed separately. There are additional options to separate 
spot colors into CYMK and to print knockouts under spot color areas.



Print - Overprint Black

Will cause all black areas to be printed over other colors thereby increasing the density of the black.



Print - Printing to a File

As noted previously, special printer driver modules can be used to output document pages to files, instead 
of paper or film. Currently, drivers are available to create single plane or color separated BMP, TIFF and 
DCS files. A choice of resolutions is available in the Printer Settings dialog box. When you click the Print 
button, a file selector appears for you to name the files you are printing to disk. The print to file option 
makes it possible to save Calamus document pages in a high resolution graphic files that can be loaded, 
edited and printed in other applications. 



Coordinate Display - Sizing

The Coordinate Display can also be used to resize a frame. Select a frame and click the Coordinate 
Display. Enter a new value or a percentage in the dX field to change the width of a frame; enter a new 
value or a percentage in the dY field to change the height.
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Installation

An Explanation and Review of our Installation Procedure

Calamus is distributed on CD ROM to provide security and easeofuse. From the Program Manager in 
Windows NT, click Run on the File menu. Type SETUP after the letter representing the drive for your CD 
ROM. For example, if the CD ROM is on E: drive, type E:\SETUP to begin installation.

Installing Calamus 
File Manager 
Installing a Printer Driver 



Installing Calamus

The Calamus installation program will run. The first dialog box requests the language for installation. The 
selected language will be used in all dialog boxes and alerts in the installation process.

Calamus Installer Dialog Box

The next alert lets you install Calamus from the CD, or remove it from your hard disk.

Calamus supports several platforms. Select the platform on which you will be running Calamus. If you 
wish, you can install a Demo Version instead of the actual program.

The installation program also searches for a previous version of the program. If a previous version is 
found, it can be updated or Calamus can be installed in a new directory. 

The next part of the installation is the selection of modules, drivers, help files, fonts, dictionaries, special 
files and samples. 

You may select the kinds of sample files to be installed. Storage space should be considered when 
choosing the components to install. If you are short of hard disk space, it is suggested that you do not 
install the larger files like bitmaps and sample documents.

The final step is the registration process where the user's name, company and serial number are entered. 
The serial number is encrypted within a 12digit number included with the package. The actual serial 
number is extracted by the installation program and entered in the registration box. Refer to the actual 6-
digit registration number when contacting DMC.

The installation concludes with the automatic creation of a Program Group and Program Item in the 
Program Manager.

To run Calamus, doubleclick the Calamus program icon, or select it and click Open in the File menu of the 
Program Manager. The Calamus logo screen will appear as the program begins to load.

Calamus Logo Screen 

The Loading File message box will display the loading of modules, fonts, text styles, color lists and other 
settings that have been saved in the CALAMUS.SET system setup file.



File Manager

To see the subdirectories and files that are installed by Calamus for Windows NT, open the File Manager 
in the Program Manager. The default directory for Calamus is named CALAMUS. Open the CALAMUS 
directory and the following list of subdirectories will appear:

COLORS color lists
CURVES control lines for color correction
DICTS spelling checker dictionaries; hyphenation tables
DOCUMENT document files
DRIVERS import and export drivers for text, bitmap graphics and vector graphics.
FONTS Calamus typesetter fonts (CFN) and TrueType fonts
KEY BINDINGS keyboard equivalent macro files
LAYOUTS master page files
MODULES modules containing various design and layout tools
PAGES individual document pages
RASTER GRAPHICS bitmap images for all supported formats
RASTER raster settings files
SCANNERS drivers for scanners
STYLES text style lists
TEXT text files in ASCII or wordprocessor formats
TEXT MACROS text macros containing style and contents
VECTOR GRAPHICS vector graphics for all supported formats



Installing a Printer Driver 

In the Windows NT operating system, printer drivers are installed in the Printers section of the Control 
Panel in the Program Manager group. Once a printer driver is installed, it may be used by any Windows 
NT application. To install a printer driver, log on as administrator and insert the Windows NT CD into the 
CD ROM drive. Doubleclick the Printers icon in the Control Panel. 

Click the Create Printer button and a list of printer drivers will appear. Select the printer driver and click 
OK. If you are installing a printer driver from a floppy disk, type Run in the Program Manager's File menu. 
Follow the instructions in the respective documentation for installation. See the Windows NT manual for 
additional information.



Configuration

The installation program creates the necessary directories and subdirectories for Calamus. During the 
installation, the CALAMUS.SET file is copied to the directory containing CALAMUS.EXE. Calamus reads 
the .SET file for startup information and loads the various modules, fonts, colors, etc. according to the 
information in the .SET file.

It is possible to change and resave the default settings for Calamus. To do so, click Save System Setup in 
the Options menu. The Save System Settings dialog box appears.

You may save the settings for any or all of the components shown above. The current settings of the 
selected components are saved to the CALAMUS.SET file and will take effect the next time Calamus is 
launched. Calamus will be loaded with the current fonts, text styles, color lists, text ruler settings and 
macros as well as other settings such as those found in the System Parameters module:

Set System Parameters Dialog Box

A description of the settings in the System Parameters module is found in chapter 5 of the manual. The 
CALAMUS.SET file also contains the settings found in the Miscellaneous Settings dialog box. 

For a description of the options, see Miscellaneous Settings in Menus, chapter 2.

The CALAMUS.SET file also holds the settings for page format and page layout. These settings are 
applied when you create a new document after launching Calamus. The options for Page Format and 
Page Layout Settings are explained in the Page Module, chapter 5.    In addition to the settings described 
above, the CALAMUS.SET file saves a number of additional program settings including the following: 
units of measurement, shadow offset, import and export drivers, printer information, file selector settings, 
text ruler settings and frame settings.

The CALAMUS.SET file is an important element for setting up Calamus. It is recommended that you set 
up Calamus according to your preferences; then make a backup copy of the CALAMUS.SET file on a 
floppy disk in case the current file becomes corrupted. Restoring the CALAMUS.SET file from a backup 
can save a lot of time.

Note: You may view the settings in the CALAMUS.SET file by loading it into any text editor. However, 
modifying the file in a text editor leads to file corruption and possible program errors. Only use Save 
System Setup to change your system settings.



Fundamentals

The next section of StartUp is an exploration of some standard
elements in Calamus. The following elements are covered in detail
in the reference manual under Standard Elements, chapter 1.

The Calamus Desktop 



The Calamus Desktop

Calamus Desktop

Calamus has a unique desktop consisting of standard Windows NT
elements and some specialized tools. The tools in Calamus are
accessed via pulldown menus, command icons and keyboard
equivalents. The command structure is covered in detail in
Standard Elements, chapter 1. Let's examine the startup desktop:

The main elements of the desktop are immediately visible
when you launch Calamus. Click on any of the following for a description of these main elements.

Menus
Module Row
Iconbar
Toolbar
Command Group
Tool Tips and Help Messages
Document Filename
Document Information
Master Page Mode
Mouse Pointers
Selectors



Modules

Every module is a complementary and integral part of the Calamus system. Nevertheless, you can load or 
delete modules without affecting the operation of the program. Calamus has been released with a number 
of modules that are optional with other DTP systems. Each module is summarized to provide a quick 
overview of the power in the Calamus system.

Page Layout Modules 
Text Handling Modules 
Graphics Handling Modules 
Color Handling Modules 
Output Modules 
System Setup Modules 
Data Exchange Modules 
Optional Modules 



Page Layout Modules

The following modules all relate to page layout. Please click on the relevant module for specific 
information.

Page (PAGE.CXM) Module 
Page Tool    (PAGETOOL.CXM) Module 
Page Preview (PREVIEW.CXM) Module 
Frame (FRAME.CXM) Module 
Toolbox (TOOLBOX.CXM) Module 



Page (PAGE.CXM) Module

The Page module handles elements associated with document pages and master pages. For any 
document you can set the page size, type (single or facing pages) and orientation (portrait or landscape). 
You can also select the system of measurement for a document. In master page mode, you can create, 
copy and assign any number of master pages to ensure a flexible yet consistent appearance in a 
document. Master pages may also be saved and used in other documents.



Page Tool    (PAGETOOL.CXM) Module

The Page Tool module can display the pages of a document in thumbnail format at selectable resolution. 
You can also insert, delete and move pages.



Page Preview (PREVIEW.CXM) Module

The Page Preview module generates a WYSIWYG image of a document page by creating a screensize 
bitmap of it. The module displays the document page in all Calamus write modes (transparent, opaque 
and inverse). This module is used for checking the final appearance of a page. For facing pages 
documents, the left and right page will be displayed.



Frame (FRAME.CXM) Module

The Frame module has 8 command groups which provide over 100 functions associated with every type 
of Calamus frame. From creation, resizing and placement of frames, to text piping, image editing, and 
display controls, the Frame module manages a large number of functions associated with layout work.



Toolbox (TOOLBOX.CXM) Module

The Toolbox module provides enhanced framehandling abilities. With the Toolbox module you can align 
frames by any edge or axis. You can also move frames to/from the master page or select frames for non-
printing. A second command group in this module lets you convert any frame type to any other type. This 
is useful if you create layouts using one style of frame, e.g. raster areas, then convert those frames to the 
required types to import text and graphics. An additional function is the ability to convert a bitmap image 
to a 1bit monochrome, 8bit grayscale, 24bit True Color or to a colorseparated CMYK file.



Text Handling Modules

The following modules all relate to text handling. Please click on the relevant module for specific 
information.

Text (TEXT.CXM) Module 
Text Style (STYLE.CXM) Module 
Text Editor (EDITOR.CXM) Module 



Text (TEXT.CXM) Module

The Text module is a powerful texthandling tool with 6 command groups to input text and layout control 
codes; select characters from any font; spellcheck and hyphenate text; manipulate text rulers; create or 
edit text macros; and provide access to the Text Editor.



Text Style (STYLE.CXM) Module

The Text Style module provides precise control over the appearance of text. This module contains 8 
command groups that include font and font size selection; text effects; text color; underline, outline and 
shadow settings; and the text style list. The text style list provides access to the creation and editing of 
any text style in a document, allowing global changes to be made quickly and effectively. Text style lists 
may also be saved and used in other documents.



Text Editor (EDITOR.CXM) Module

A specially designed Text Editor module provides standard wordprocessing functions such as block 
operations, search and replace, and bookmarks. However, the power of the Calamus Text Editor is in its 
ability to insert and edit text, ruler and layout control codes that affect the appearance of a document. Text 
flows easily between text frames and the text editor. In addition, you may also configure several items in 
the Text Editor to suit your preferences.



Graphics Handling Modules

The following modules all relate to graphic handling. Please click on the relevant module for specific 
information.

Line (LINE.CXM) Module 
Raster Area (RASTER.CXM) Module 
Brush (BRUSH.CXM) Module 
Rotate (ROTATE.CXM) Module 
Blend (BLEND.CXM) Module 
Vector Editor (VECTOR.CXM) Module 
Mask (MASK.CXM) Module 



Line (LINE.CXM) Module

The Line module provides the ability to create and edit a variety of lines. You can control the color of lines 
and their shadows, as well as the line style and line ends used. Effective use of lines can significantly 
improve layout designs.



Raster Area (RASTER.CXM) Module

The Raster Area module lets you draw and size any of 15 predefined raster shapes. Color settings can be 
selected, as well as border color, line style and line weight. This module also contains shadow color and 
offset functions.



Brush (BRUSH.CXM) Module

The Brush module is an image editing tool that allows you to create or edit color bitmap images. A 
number of brushes are included, along with an Undo feature. The Brush module also accesses the full 
color list created with the Color Settings module.



Rotate (ROTATE.CXM) Module

The Rotate module is designed for rotating a bitmap images to any degree without aliasing. This module 
can also generate rotations with a mask to create clean edges in tone images.



Blend (BLEND.CXM) Module

The Blend module creates color gradient blends in both linear and circular formats. You can also control 
the number of blends, angle of gradient, background and foreground colors, optimal size, and direction of 
gradiation. This module works with any raster graphic frame and can be used with the Mask module to 
create visual effects. 



Vector Editor (VECTOR.CXM) Module

The Vector Editor module is used to edit the colors, fill patterns and vector paths in a vector graphic. You 
can also create new paths and objects in a vector graphic, or trace a bitmap graphic with a vector path. 
The Vector Editor contains many frame tools found in the Frame and Raster Area modules. The Vector 
Editor provides powerful vector image editing ability within Calamus.



Mask (MASK.CXM) Module

The Mask module brings powerful masking functions to the Calamus workspace. The module has only 
two commands but can create an unlimited number of special effects. You can create opaque or 
transparent masks; color and grayscale effects; knockouts; text fills with blends; collages of halftones; 
textured pattern fills in any object and much more.



Color Handling Modules

The following modules all relate to color handling. Please click on the relevant module for specific 
information.

Color Settings (COLOR.CXM) Module 
Focoltone (FOCOLTON.CXM) Module 
Color List Converter (COLFORM.CXM) Module 
CMYK Swap (CMYKSWAP.CXM) Module 
Color Separation (COL_SEP.CXM) Module 



Color Settings (COLOR.CXM) Module

The Color Settings module is the heart of the Calamus color control system. This module is accessed by 
many other modules to select color and fill patterns. You can also create and edit process colors and spot 
colors using RGB, CMYK, and IHS color systems. The Color Settings module supports True Color and 
can also load color palettes such as Focoltone.



Focoltone (FOCOLTON.CXM) Module

The Focoltone module contains industry standard color palettes that can be combined with swatch books 
and other accessories to ensure exact color matching in the prepress process. Colors from this module 
are loaded into the Color Settings module for use in a document. The icon for this module appears on the 
Iconbar.



Color List Converter (COLFORM.CXM) Module

The Color List Converter is used to create list colors from the free colors found at the top of several 
command groups or from imported graphics. This module will read the RGB settings for all free colors and 
list them as RGB values in the color list. Then you can use the new list colors for precise color matching 
in other elements of a document.



CMYK Swap (CMYKSWAP.CXM) Module

The CMYK Swap module lets you exchange the process colors in a selected image. This can produce 
some interesting effects. Colors will be properly separated to reflect the swapped color planes.



Color Separation (COL_SEP.CXM) Module

The Color Separation module is used to separate color planes in the printing process. This module lets 
you edit GCR (Gray Component Removal) and UCR (Under Color Removal) settings in order to calibrate 
color output. The Color Separation module separates color layers during printing.



Output Modules

The following modules all relate to output. Please click on the relevant module for specific information.

Linearity (LIN.CXM) Module 
Raster Generator (RASGEN.CXM) Module 
StarScreening (STAR.CXM) Module 
Mount (MOUNT.CXM) Module 
Windows Bitmap Driver (BMP.CXM) 
Tagged Image File Format Driver (TIFF.CXM) 
Desktop Color Separation (DCS.CXM) 
Dummy Typesetter Driver (DUM.CXM) 



Linearity (LIN.CXM) Module

The Linearity module is used to optimize color output for your printer. Each printer handles color with 
slight differences. This module lets you calibrate your color output to match your printer's characteristics. 
The Linearity module uses CK4 and CK7 color correction control lines. You can edit the control lines for 
special effects and save them for future use.



Raster Generator (RASGEN.CXM) Module

The Raster Generator module is used to control the line screening of a document during the printing 
stage. With this module you can set raster angle, width, shape and bias for each color plane. Raster 
settings can be saved in files corresponding to specific output devices and line screening requirements. 
The Raster Generator module provides precise control over output to any device.



StarScreening (STAR.CXM) Module

The StarScreening module uses stochastic screening technology to create high resolution versions of 
selected frames up to 3000 dpi. (The basic version of this module prints starscreened frames up to 750 
dpi; the Pro version is required to print at higher resolutions.) With the StarScreening module it is possible 
to eliminate moire effects in bitmap images by employing the variable dot patterns used in frequency 
modulated screening.



Mount (MOUNT.CXM) Module

The Mount module is a basic imposition tool that will print multiple pages on each sheet of paper. Printing 
options allow magazine, book and consecutive printing order. It is also possible to print multiple copies on 
one sheet of paper.



Windows Bitmap Driver (BMP.CXM)

The Windows Bitmap Driver can be selected as a printer driver in the Printer Settings dialog box. This 
module lets you send a specified document page to a Windows BMP file in monochrome, grayscale or 
True Color ranging from 50 to 1270 dpi resolution. This function is useful for exchanging proofs of pages 
in bitmap form. Pages may also be colorseparated to individual color plane files.



Tagged Image File Format Driver (TIFF.CXM)

The Tagged Image File Format Driver can be selected as a printer driver in the Printer Settings dialog 
box. This module lets you send a document page to a TIFF 6.0 file in monochrome, grayscale or True 
Color at 50 dpi to 1270 dpi resolutions. This module also supports color separation and spot colors by 
sending each plane to separate 1bit files.



Desktop Color Separation (DCS.CXM)

The Desktop Color Separation file will output an industry standard DCS file that can be read in an 
external application in resolutions from 150 to 2400 dpi. The DCS module separates color planes into four 
high resolution TIFF files.



Dummy Typesetter Driver (DUM.CXM)

The Dummy Typesetter Driver is used for performance testing and for estimating output time. The module 
supports monochrome output from 600 to 3000 dpi. The Dummy Typesetter emulates a typesetter; 
instead of sending a rastered image to be printed, the image is discarded. When "printing" is finished, a 
dialog box shows the output resolution, number of pages processed, total printing time and average 
printing time per page.



System Setup Modules

The following modules all relate to the system setup. Please click on the relevant module for specific 
information.

System Parameters (SYSTEM.CXM) Module 
Document Converter (DOC_CONV.CXM) Module 
Font Loader (FONTLOAD.CXM) Module 



System Parameters (SYSTEM.CXM) Module

The System Parameters module is used to define several default settings for using Calamus. These 
settings include the option to use the Calamus or Windows file selector; standard or custom screen 
resolution; date and time formats and the size of a buffer for vector output. When settings have been 
entered, use Save System Setup to make them the default settings when you next launch Calamus.



Document Converter (DOC_CONV.CXM) Module

The Document Converter module does not have an icon or a dialog box. It works transparently when 
loading a Calamus CDK file created in a previous version of the program.



Font Loader (FONTLOAD.CXM) Module

The Font Loader module does not have an icon or dialog box. It works transparently when loading 
Calamus format (CFN) typesetter fonts. When CFN fonts are loaded, the vector information is converted 
and stored in the TMP subdirectory.



Data Exchange Modules

The following modules all relate to data exchange. Please click on the relevant module for specific 
information.

Clipboard Module 
Windows Clipboard (WINCLIP.CXM) Module 
EPS Handler (EPS.CXM) Module 
Object Linking and Embedding (OLE.CXM) Module 
Scanner (SCANNER.CXM) Module 



Clipboard Module

The internal Clipboard module is loaded automatically with CALAMUS.EXE. It can be used in text or 
frame mode. In text mode, text blocks or entire piping chains may be cut or copied to the clipboard and 
pasted into another text frame. In frame mode, any Calamus frame type can be cut or copied to the 
clipboard, and pasted on any document or master page.



Windows Clipboard (WINCLIP.CXM) Module

The Windows Clipboard module can be used to cut or copy text, bitmap images or vector graphic images 
to the Windows clipboard. Data can be shared with other Windows applications or within Calamus.



EPS Handler (EPS.CXM) Module

The EPS Handler module lets you import EPS files into uniframes. This module supports the Adobe 
Illustrator format. EPS objects can be viewed and printed with or without preview data. Embedded fonts 
may be downloaded to a PostScript printer or not printed at all.



Object Linking and Embedding (OLE.CXM) Module

The Object Linking and Embedding module permits the sharing of data between Calamus and any OLE 
supported Windows application. With OLE you can link applications so that data created or edited in one 
is automatically updated in the respective uniframe in Calamus.



Scanner (SCANNER.CXM) Module

The Scanner module lets you scan bitmap images directly into a Calamus raster graphic frame. The 
module will use any file format or resolution supported by your scanner. The Scanner module also uses 
any prescan options that are available in your scanner. Scanner drivers specific to different models may 
be purchased from DMC.



Optional Modules

The following modules are optionally available. More are being added on a regular basis. Please click on 
the relevant module for specific information.

Line Art (LINEART.CXM) Module 
StarScreening Pro (STARPRO.CXM) Module 
Blend Pro (BLENDPRO.CXM) Module 
Transparency (TRANS.CXM) Module 
Measurement (CQR.CXM) Module 
PhotoFX (PHOTOFX.CXM) Module 



Line Art (LINEART.CXM) Module

This module provide enhanced vector editing functions including text and object manipulation to create 
advance effects found in commercial applications. Map text along a definable path or project on to a 
control grid; create vector objects and apply an infinite number of colors plus a selection of fill patterns.



StarScreening Pro (STARPRO.CXM) Module

This module lets you print starscreened images at 750 dpi to 3000 dpi resolution on a typesetter device. 
Images output at these resolutions have photographic quality. You can also convert starscreened frames 
to bitmap frames or to TIF 6.0 files.



Blend Pro (BLENDPRO.CXM) Module

This module creates enhanced color gradients with multiple blends and also have load/save functions for 
custom blends that you create.



Transparency (TRANS.CXM) Module

This module uses the alpha channel for creating transparent frames at definable levels of opacity. The 
most advanced graphic effects are at your fingertips with this module.



Measurement (CQR.CXM) Module

This module is a utility for measuring the linear distance between two points. This module will also 
calculate the dX (width) and dY (height) distances, along with the angle of the line connecting the two 
points.



PhotoFX (PHOTOFX.CXM) Module

This module creates interesting special effects such as embossing or sharpening bitmap graphics. The 
module includes a number of definable settings including the ability to select the source direction for filter 
effects.



Practice

In the DOCUMENT subdirectory is another subdirectory called SAMPLES. Practice loading and saving 
the sample documents. Don't worry about overwriting files. The samples may be reloaded from the 
Calamus CD ROM at any time by using the Installation program.



Printing in General

Calamus has many options for printing a document. These options are covered in Printer Settings, 
chapter 3. Following is a summary of some print options.

Calamus can print a document using the Windows NT Print Manager (the default method) or by directing 
output directly to a printer. In either case, the printer driver must be installed in Windows NT by using the 
Control Panel in the File Manager. If you have not installed a printer driver, Calamus will not be able to 
read the printable area for a page. The printable area data is required for Tiling functions and Fit to Size in 
the Printer Settings dialog box. In addition, the printable area guideline will not be displayed in the frame 
guidelines.

When you click Print Document in the File menu, the Printer Settings dialog box appears. It contains four 
sections called "tab" dialog boxes. Each of the tab dialog boxes is fully explained in chapter 3. For 
purposes of the Quick Tour, a short summary of each item follows along with the default setting in 
parentheses.

Tab Dialog Feature Summary 

Printing is a complex function within Calamus. In addition to printing options covered in chapter 3, the 
following information is also noteworthy.

Tiling frames may be used to print selected portions of a page. These specialized printing tiles may be 
sized to fill the printable area or reduced to create thumbnail printouts of document pages. See Tiling 
frames in the Frame Module, chapter 5.

One option in the Set Magnification dialog box is Printer 1:1. This mode will display a document in oneto-
one correspondence with the currently loaded printer driver. In effect, each screen pixel matches each 
printer pixel. This method is used for precise editing of images and placement of layout elements.

A final word about the printing process: printing resolution is dependent on the ability to convert text and 
graphic data to raster points that are printed on an output device. Appendix D in the manual provides the 
fundamentals of this process. In addition, the section on the Raster Generator module in chapter 3 
contains applied examples of the rasterization process.



Tab Dialog Feature Summary

Copies (1) - will print each page once.
Scaling (100) - will print pages at actual size.
Fit to Page (off) - will not scale page to fit printable area.
Print Range (All) - will print all pages in document.
Orientation (Automatic) - selects orientation for best fit of page size.
Sort (Up) - prints pages from beginning to end or from Minimum page 

setting to Maximum page setting if Selected was chosen in the
 Print Range. 
Tiling (Whole) - prints the entire page and ignores any tiling frames.
Duplex (None) - will not print on both sides of page for printers which support this

feature.
TrueType (Download) - sends TrueType fonts to PostScript printer before sending page

for printing.
Collate (off) - will not collate document pages if multiple copies are entered.
Options (none) - does not select inverse or mirror printing, layout marks or page 

imposition using Mount.
Pattern (x1) - will print fill patterns at original 300 dpi resolution.
Layout Elements - calls the Page Layout Settings dialog box.
Use SoftRipping on 
PostScript devices (off) - will not use SoftRipping
User Generic Windows (off) - will not print document using the Windows printer driver.
Single Plane (on) - will combine color planes for onepass printing.
Color Separation (off) - active if Color Separation module is loaded; will allow selection of 

color planes to be separated and printed.



Dynamic Linking

Calamus frames are dynamically linked in another way. It is possible to apply some functions to several 
frames at the same time, even if they are not virtual copies. For example, you can rotate or mirror 
different frame types at the same time. You can also change the color settings, line weight or line style of 
several line or raster areas.



Converting Frames

The Toolbox module contains a command group with functions to convert any frame type to any empty 
frame of another type. In the process of conversion, any data contained in the original frame is deleted. If 
the frame is part of a text chain, text will be piped among the remaining frames.

The Convert Frame functions are useful if you prefer to create layouts using one type of frame, e.g. raster 
areas. When ready to import text, graphics and other data, convert the raster areas to the required frame 
type.



Masking

The Mask Module section of chapter 5 provides several examples of masking applications. For our 
purpose here it is only necessary to note that any type of Calamus frame may be used to mask another 
frame. The creative masking of frames can be used to produce some ingenious designs. In the case of 
masking, experimentation is greatly encouraged. Here are some examples of the effects created with the 
Mask module:



Master Pages

Master Pages provide an effective method for creating and applying layout elements which are common 
to several pages in a document. For example, in this manual there is a header and footer on the master 
page.

As you can see, both the header and footer both contain text and a line. The header also has a bitmap 
image of the icon representing the contents of the text. The footer holds the page number. Actually, it 
holds a control code for page numbering which is then translated to an actual number on the actual 
document pages.

This book has several master pages. A different master page is assigned to each chapter of the manual. 
Flip through the book and you will see that the text and graphic in the headers indicate the contents of 
each chapter. The other elements (line, page number, footer text) are the same for each chapter.

The consistency among the headers and footers was accomplished by copying the master page for the 
first chapter and modifying its header text and graphic for the second chapter. The process was repeated 
for each chapter, resulting in several master pages for this book.

Each master page was then assigned to a range of pages in which the content related to the header text. 
Master pages may be created and assigned to single or facing pages layouts.
You may have also noticed that StartUp has the same design elements as the Calamus manual. This was 
easily achieved by saving one master page used in the manual, and applying that master page to the 
StartUp document. Similarly, the text style and color lists were also imported from the manual document 
into StartUp.

There are other ways to use master pages. In addition to holding text and graphic data, master pages 
may also contain guidelines for frame placement. The SAMPLES subdirectory contains several master 
pages with different guideline patterns. These patterns can be applied to any page size to create 
guidelines for rows and columns.

There are several ways to view a master page. If you are using a single page layout, one page will be 
displayed in Full View mode when you click the master page icon in the Toolbar. If the document uses a 
facing page layout, both pages will be displayed in Full View mode. 

Clicking the Page Preview icon in the Toolbar while in master page mode will engage the Preview 
module. This view will show the master page in true WYSIWYG; all write modes will be visible.

There is one limitation for using master pages. Empty frames, such as those used to import text and 
graphics, will not display on document pages. To create empty text and graphic frames on new document 
pages, use the Copy Layout option in the Insert Empty Pages function of the Page module. For complete 
information on master pages, see Page Module, chapter 5.



Text Handling Tutorial

This section of the Quick Tour will explore three key modules used to work with text: Text, Text Style and 
Text Editor. Each of these modules is presented in detail in chapter 5 of the manual. 

Text Module Tutorial 
Text Style Module Tutorial 
Text Editor Module Tutorial 



Text Module Tutorial

Click on the appropriate item of interest below for further information:

Text Frames 
Text Entry Tips 
Kerning Text 
Text Rulers 



Text Frames

Text frames hold text which may be entered from the keyboard or imported from other applications as files 
or clipboard data. The Text module contains 6 commands groups to work with text: Control Codes, Tools, 
Dictionary, Character Set, Text Rulers and Macros. 

For Quick Tour purposes the focus will be on some basic items associated with this module.

A text frame is created in the same way as any other Calamus frame. Click the text frame icon in the 
Tools command group of the Frame module and draw a text frame.

Text Piping Chains 
Exporting Text 
Editing Text 
Marking Text 
Cut, Copy and Paste Text 
Drag and Drop Text 



Text Piping Chains

The process of flowing text from one text frame to another is called "piping". The text is referred to as a 
piping chain or a text chain. It is possible to pipe text between frames on the same page or on different 
pages. You can also create an empty text chain before you import text into it. In fact, this is the quickest 
way to import text.



Exporting Text

It is also possible to export text to a file in one of several text formats. To do so, select a text frame (a 
single frame or one in a piping chain) and click Export in the File menu. The Export Text object selector 
will appear with several export drivers already loaded. 

Click the export driver for the type of file you wish to export; if the driver is not loaded, click the Load 
button and select the required driver when the file selector appears. (The Installation program has preset 
the path to the Calamus drivers.) 

Click the Export button and the file selector appears. Locate the
path and enter a filename for the text file you wish to export. Click OK and the text will be exported to a 
file in the selected format.

The Export Text function is useful if you wish to design a new layout with existing text. By exporting the 
existing text chain in Calamus Text Document (CTD) format, all text style and layout control codes will be 
retained. You can edit the codes after importing the CTD file into your new document.



Editing Text

It is possible to edit text in text frames by using the Text module. You can spellcheck and hyphenate 
individual words, text blocks or complete piping chains. You can also insert and edit layout control codes 
and text rulers. These functions are discussed below. 

To enter editing mode, select a text frame and click the Text module icon. The mouse pointer changes to 
an Ibeam cursor when you click in the text frame. You may use the keyboard or the mouse to move the I-
beam cursor. Both methods are described in the following paragraphs.

To move around the text frame, press the arrow keys. The Ibeam cursor will move one letter when you 
press the [Left] or [Right] arrow keys. To move the cursor from the beginning of one word to the beginning 
of another, press the [Control] key while typing the
[Left] or [Right] arrow keys. To move up or down a line, press the [Up] or [Down] arrow keys. To move 
quickly to the top or bottom of a text frame, press the [PageUp] or [PageDown] keys.

Often, a text frame is part of a piping chain. Pressing the [Up] key when at the top of such a frame will 
move the Ibeam cursor to the bottom of the previous frame in the piping chain. Conversely, pressing the 
[Down] arrow key when at the bottom of such a frame will move the Ibeam cursor to the top of the next 
frame in the piping chain.

Editing text in text frames is the same as in any word processor. The [Backspace] key will move the 
cursor to the left and delete the letter, space or control code under the cursor. The [Delete] key will draw 
text to the cursor from the right, and erase each letter, space or control code under the cursor. 



Marking Text

The Text module also follows standard Windows conventions for marking text. Holding down the [Shift] 
key while pressing the [Left] or [Right] arrow key will mark the text as the cursor moves over it. Pressing 
the [Up] or [Down] arrow key will mark all the text on a line. To quickly mark a word, press [Shift] and 
[Control] as you move the [Left] or [Right] arrow key. To mark a single word with the mouse, doubleclick 
on the word and it will become highlighted.

To mark a line of text, move the cursor to the beginning of the line and press [Shift] and the [Down] arrow 
key. The whole line will become highlighted. To use the mouse to mark a line of text, tripleclick anywhere 
on the line.

To mark an entire paragraph using the mouse, rapidly click the mouse button four times while the Ibeam 
cursor is anywhere in the paragraph. The entire paragraph will become highlighted. 

To mark an entire piping chain, rapidly click the mouse button five times while the Ibeam cursor is 
anywhere in the piping chain. The entire piping chain will become highlighted. Do not press the 
[Backspace] or [Delete] keys; the entire text chain will be erased!

To delete a word, mark it by using [Control] and an arrow key or by double-clicking on the word; then 
press the [Delete] or [Backspace] key. The following alert will appear:

Click Delete to confirm deletion of the marked text.



Cut, Copy and Paste Text

Text can be cut or copied from a text frame and pasted elsewhere in the same frame or in another one. 
The cut, copy and paste functions can be done by using the Clipboard module or the Windows clipboard 
in the menu bar. In both cases you mark text and then click the command icon in the Clipboard module or 
Cut or Copy item in the Window pulldown menu. To paste text, position the Ibeam cursor and click the 
Paste icon or menu item. 

It is possible that the Name Conflict alert box will appear. If you are pasting text into the same document, 
select Replace in the Name Conflict alert box. If you are pasting text into a different document, click the 
Rename button in the Name Conflict alert box.



Drag and Drop Text

You can also use the Drag and Drop feature to quickly move text in
a text frame. To do so, mark text using the arrow keys or by dragging the Ibeam cursor over text with the 
mouse. Press and hold the Ibeam cursor on any part of the marked text. A vertical bar will replace the I-
beam cursor. Use the mouse to position the vertical bar at the point where you want to move the marked 
text. Release the mouse button and the marked text will appear in the new location.



Text Entry Tips

As you enter text from the keyboard, the text frame will be reformatted and the screen will be redrawn. 
Waiting for a screen redraw after entering a few letters can be time-consuming. It is possible to delay the 
redraw by setting a Text Input Delay in the Key Bindings Editor of the Tools command group in the Text 
module.

Key Bindings Dialog Box

In this dialog box you can see that a number key bindings are available to enter hyphenation, dashes, 
fixed spaces, line ends, quotation marks and some miscellaneous functions. It would be productive to use 
these key bindings while entering or editing text in text frame mode.



Kerning Text

Kerning is the process of changing spacing between characters. You can kern space in both horizontal 
and vertical directions. To kern text, you must change for from text mode to kerning mode by pressing the 
[Esc] key. 

This will change the Ibeam cursor to an Lshaped kerning cursor. Press [Shift] and the [Right] arrow key to 
increase horizontal spacing between two letters; [Shift] and the [Left] arrow key to decrease horizontal 
spacing.

To kern vertically, press [Shift] and the [Up] arrow key to move text up; press [Shift] and the [Down] arrow 
key to move text down. For coarser kerning, use the [Control] key instead of the [Shift] key. To insure 
accuracy, manual kerning should be done by using a magnified view.



Text Rulers

Calamus uses a system of text rulers to govern margins, paragraph indents, justification, line spacing, 
paragraph spacing and tab style and placement. 

All text ruler functions are found in the Text Ruler command group of the Text module.

A text ruler governs the formatting of text until the next text ruler is encountered in a frame or piping chain. 
It is possible set a text ruler for a single frame or paragraph by using the Insert Text Ruler command. You 
can also change the settings of a text ruler by pressing [Shift] and clicking the text ruler. The Edit Text 
Ruler dialog box appears as shown below:

Ruler Settings Dialog Box

Upon exiting the dialog box, all new settings are applied to the selected text ruler and text is reformatted. 
For information about the various text ruler settings, see the Text Ruler command group in the Text 
Module, chapter 5. 



Text Editor Module Tutorial

The Text Editor module lets you edit text and layout control codes in a text editor window. There are some 
similarities between the Text Editor and the Text module. Cursor movement, text editing and access to 
text style and text ruler dialog boxes are the same. The Text Editor also has Search and Replace 
functions, block operations and Drag and Drop capabilities.

To enter the text editor window, select a text frame and click the typewriter icon in the Tools command 
group of the Text module.

The text in the selected piping chain is copied to the text editor window. When you have finished editing, 
you can send the text back to the selected text frame by clicking Exit in the File menu of the text editor. 
Three options are presented:

Add will copy the text from the text editor to the end of the piping chain for the selected frame.

Replace will overwrite the text in the piping chain with the text from the text editor window.

Merge will insert the text from the text editor window into the text frame at the cursor position.

If a text block was marked in the text frame, a fourth option is available. Block will replace the marked text 
with the text from the text editor window. 

If you wish to close the text editor window without sending text into the text frame, click Abort in the text 
editor's File menu. You will be prompted to save the text in the editor. If you select Yes, the Send Text into 
Text Frame dialog box will appear, as discussed above.

Editing Text in the Text Editor 
Editing Control Codes 



Editing Text in the Text Editor

The same keyboard conventions are used in the text editor as in    the text frame. The arrow keys move 
left, right, up and down the    text. Pressing [Shift] and arrow key will mark text. Pressing [Shift] and 
[Control] while moving the cursor keys will mark whole    words. Pressing [Shift] while moving the [Up] or 
[Down] arrow keys will mark complete lines. 

The deletion of text using the [Delete] and [Backspace] keys is    the same as in the Text module. 



Editing Control Codes 

In addition to text, three kinds of control codes appear in the    text editor window: text style, text ruler and 
layout control codes. The code for text styles is [s]; its long form    is [style]. The code for text rulers is [r]; 
its long form is [ruler]. 

Text style codes and text ruler codes are used to control the appearance and formatting of text in your 
document. To change the attributes of a text style or ruler control code, doubleclick on the [s] or [r] codes 
in the text editor. The respective dialog boxes will appear for you to edit the control codes:

Select Style Dialog Box

Edit Text Style Dialog Box

You can select a different text style or edit an existing one.    When you doubleclick the [r] button, The 
Ruler Settings dialog box appears for you to change any attribute in the selected ruler.

The third kind of control codes, called layout control codes, govern a number of text and layout    
functions. 

Short Form Long Form 

[p] [Page #] 
[np] [Next Page] 
[c] [Hyphenation] 
[k] [Manual Kerning] 
[pnf] [Pipe to Next Frame] 
[i] [Index Entry] 
[ref] [Text Reference] 
[rem] [Reference Marker]
[f] [Footnote] 
[d] [Date] 
[t] [Time] 
[vhs] [Variable Hard Space] 
[afd] [Anchor Frame Data] 
[com] [Comment] 
[pb] [Protected Block] 
[dc] [Drop Cap] 

Double-clicking a layout control code will call its respective dialog.



Text Style Module Tutorial

The Text Style module lets you apply fonts and text effects to text in your document. Calamus supports 
TrueType (TTF) fonts as well as its own CFN typesetter quality format. (To use CFN fonts, the Font 
Loader module must be loaded in the Modules dialog box.) Fonts may be sized from 1 to 999 pts in size 
with accuracy up to 4 decimal places. Text effects include underline, outline and shadow effects. You can 
also create skewed, compressed, expanded, subscript and superscript text.

The Text Style module accesses the same color lists as other Calamus modules. This lets you use 
process or spot colors in normal text or in outlines, underlines or shadows.

Calamus text styles may be defined as internal or list text styles. The differences between them are 
explained in Chapter 5 of the manual. For purposes of the Quick Tour, it is only important to note that text 
style lists allow global editing of text styles from a single dialog box. This feature is covered later in this 
section of the Quick Tour.

The Text Style module has 8 command groups: Font Selection, Font Size, Text Effects, Text Attributes, 
Underline, Outline, Shadow and Text Style List.

Text styles may be created in a number of ways depending on your own preferences. If you wish to 
experiment with text styles on a particular text block, select the attributes in the various command groups: 
font, size, effects, underline, outline and shadow. Then click the Change Text Style icon in the bottomleft 
corner of several command groups. The attributes you have chosen will be applied to the text block. If no 
block was marked, an alert will ask if you want to apply the text style to the entire text piping chain. 

Proceed carefully as "Yes" will replace all other text styles with the one currently selected.

A second way to create a text style is to use Add Text Style to List in the Text Style List command group. 
When you click this command icon, the Edit Text Style dialog box appears. All of the currently selected 
attributes will be displayed and a name for the new text style will be generated automatically on the top 
line. A sample of the Edit Text Style dialog box is shown on the next page.

The third way to create a text style is to edit an existing style. This can be done in the Text Style List 
command group or inside the Text Editor.

To change a text style in the Text Style List command group, click the Change Text Style Settings 
command icon. Then click a text style name in the text style list. The Edit Text Style dialog box appears.

Any changes made to an existing text style will affect all text to which the respective text style has been 
assigned. For example, if a text style called BODY ITALIC is changed from 10 pt to 12 pt, all text using 
the BODY ITALIC text style will be reformatted to 12 pt when you exit the dialog box.

To change a text style while working in the Text Editor, doubleclick the [style] or [s] button that immediately 
precedes the text you want to restyle; the Select Style dialog box will appear and the name of the 
selected style will be highlighted. Click the Select button to call the Edit Text Style dialog box and make 
the required changes.



Internal and List Text Style

Internal text styles are usually created by marking text and clicking the Change Text Style icon. The 
marked text is reformatted according to the current attributes in the various command groups of the Text 
Style module. An internal text style appears in the Text Style List as long as it is in use. A double arrow 
appears in front of its name.

A list text style is one which remains available in the Text Style List even when it is not currently in use in 
the document. Both internal and list text styles may be modified as discussed on the previous pages. 
Both internal and list text styles can be saved and loaded into different documents.

You can also save a text style list as a system default that loads whenever you launch Calamus. To do 
save, save a text style list then Save System Setup in the Options menu. The name of the text style list 
will be saved in the CALAMUS.SET file.



Graphics Tutorial

Calamus supports both bitmap and vector graphics in a number of formats. Graphics may be imported, 
exported, edited and even created within Calamus. For purposes of the Quick Tour, we will examine the 
methods for importing and exporting graphics as well as an overview of the tools available for editing.

Graphics Frames 



Graphics Frames

Graphics are handled using three kinds of frames: raster graphic (for bitmaps), vector graphic and 
uniframe. A number of graphic formats are supported for importing both raster graphic and vector graphic 
frames. Uniframes are special frames that are used to hold data that is imported via a specific module. 
For example, EPS graphics are imported into uniframes using the EPS Handler module. The OLE module 
can also be used to exchange graphics data between a Calamus uniframe and any OLE application.

Importing/Exporting 
Uniframes 
Optimizing 
Mirror and Rotate 
Editing Graphics 



Importing/Exporting

After drawing a raster or vector graphic frame, click Import in the File menu. The Import Graphic object 
selector will appear. A number of import drivers will be loaded. If you require a driver for a different format, 
click the Load button and select the driver from the file selector which appears.

To import a graphic, select the name of the driver for the format you desire, then click the Import button. 
When the file selector appears, click the name of the graphics file you wish to import. The graphic will 
load into the graphics frame you originally selected. Note: You must select a raster graphic frame to 
import a raster graphic and a vector graphic frame to import a vector graphic.

The procedure for exporting a graphics frame to a file is similar to that used for importing. Select the 
graphics frame and click Export in the File menu. The Export Graphic object selector appears. Select the 
desired format and then click the Export button. When the file selector appears, enter a filename and click 
OK to save the graphics data in the selected file format.



Uniframes

The uniframe is a special Calamus frame type that is used to import data with the assistance of a specific 
module. After drawing an empty uniframe, select the module corresponding to the data to be imported. 
For example, to import an EPS graphic, select the EPS Handler module. To import data from an OLE 
application, select the OLE module.



Optimizing

Graphics are saved with specific heighttowidth ratios. When importing a graphic into a raster graphic or 
vector graphic frame, the frame's heighttowidth ratio will not match that of the imported graphic. This 
creates distortion in the appearance of the graphic. Calamus has a quick optimizing function that restores 
the heighttowidth ratio for raster and vector graphics.

To optimize a raster graphic, go to the Raster Graphic Special Functions command group of the Frame 
module. You can optimize a selected raster graphic frame to correspond to the screen resolution. This 
means that each pixel in the graphic will correspond to its own pixel on the screen.    Optimizing a Bitmap 
Graphic 

You can also optimize a raster graphic to match the printer resolution. First, make sure a printer driver is 
loaded in the Printer Settings dialog box. When you select Optimize to Printer, each pixel in the graphic 
will correspond to a single pixel in the print out.

Since the screen resolution is usually lower than the printer's, the optimized graphic will appear very small 
on screen. To see it better, go to the User Defined View with magnification set to Printer 1:1 in the Set 
Magnification dialog box. In this view, each screen pixel corresponds to a single printer pixel.

To optimize a vector graphic, go to the Vector Graphic Special Functions command group in the Frame 
module. Select the vector graphic frame and then click the Optimize to Ideal Size command icon. The 
vector graphic will be restored to the heighttowidth ratio with which it was originally created.    Optimizing a 
Vector Graphic 

To optimize a graphic imported into a uniframe, select the uniframe and click the Ideal Size icon in the 
respective module.



Mirror and Rotate

All Calamus frame types can be mirrored along the vertical or horizontal axis. The Mirror command icons 
are found in the Miscellaneous Functions command group of the Frame module.

With the exception of raster graphic frames, you can precisely rotate any Calamus frame to any degree 
using the Rotate function in the Frame Miscellaneous Functions command group. For raster graphic 
frames, the Rotate function only works in multiples of 90 degrees. 

To rotate a raster graphic frame in any degree, use the Rotation module. This module has an antialiasing 
feature to reduce moiré patterns in rotated raster graphics and a masking option to produce clean edges.



Editing Graphics

You can edit both raster and vector graphics by using the appropriate modules. Raster graphics can be 
edited using the Brush module. You can use a variety of brush sizes and styles as well as any color 
available in the color list. 

The Color List Converter module can also be used with imported raster graphics. With it, the "free" colors 
in an imported graphic can be converted to list colors which can then be modified using the Color Settings 
dialog box. You can also use the Color Settings dialog to import spot colors to apply in raster graphics.

To edit vector graphics, you have the Vector Editor module. Any vector graphic can be imported into the 
Vector Editor and changes can be made to paths, objects and fill colors and patterns. The optional Line 
Art module provides more sophisticated editing tools for vector graphics, including the ability to map text 
along definable paths.

Color Lists 
Color List Converter (COLFORM.CXM) Module 
CMYK Swap (CMYKSWAP.CXM) Module 
Color Look Up Tables 



Color Lists

Calamus uses a color list system for creating and accessing process and spot colors. The color list 
system is described in chapter 4, Color Settings module. Color values can be edited in RGB, CYM, CYMK 
and K systems. You can also import palette colors using the respective modules. 



Color Look Up Tables

Calamus provides excellent tools to calibrate color. Color Lookup Tables (CLUT) are used in the Frame 
module, the Linearity module and the Color Separation module. In each CLUT, control lines are used to 
manipulate color characteristics. The control lines may be adjusted freehand, or by using bézier or 
gamma curves. You can adjust brightness and contrast as well as invert individual color channels. The 
CLUT's also contain an internal clipboard plus load and save functions. The CLUT's use control lines that 
are saved in various file formats:

CK1 1color channel (monochrome and grayscale)
CK3 3 color channel (RGB) 
CK4 4 color channel (CYMK)
CK7 7 color channel for Gray Color Removal and Under Color Removal

For more information on using the Color Look Up Tables, see the respective sections of the Linearity 
module in chapter 3, the Color Separation module in chapter 4 and the Frame module in chapter 5.



Menus

A standard pulldown menu system provides access to functions that are often used. The menus are 
described in Menus, chapter 2.



Module Row

The Module Row holds the icons for most of the Calamus modules. A maximum of 240 modules may be 
loaded. 

The scroll arrows at the right end of the Module Row let you display module icons that are out of view. 
The default setting will display 20 icons but the Module Row may be stretched to show 42 icons at a time.



Iconbar

The Iconbar is similar to the Module Row. The Iconbar contains
icons for modules that are not displayed in the Module Row. The
screenshot above shows the icons for three modules: System
Parameters, CYMK Swap and the Focoltone Color Palette.



Toolbar

The Toolbar has two main components. The left side controls the
display of document and layout pages; the right side is the
Coordinate Display. Calamus lets you quickly change between Full
Page or Actual Size view. You can also choose a UserDefined View;
go to a master page; go to any document page; and view a WYSIWYG preview of a document page. On 
the right side, the Coordinate Display is used by a number of program functions to precisely place frames, 
rules, text rulers and other layout elements.



Command Group

On the left side of the screen is the command group display. A command group holds the command icons 
associated with a particular module. Some modules have more than one command group, each with its 
own set of command icons. At the right is the Tools command group of the Frame module.



Tool Tips and Help Messages

Tool Tips are the small help messages that describe each icon. Tool Tips appear under the mouse pointer 
when you rest it on an icon for two seconds or longer. At the bottom of the screen you will see the Help 
Message containing a longer description of the function associated with the icon on which the pointer is 
resting.

Tool Tips and Help Messages help you learn to use Calamus. As you become more proficient, you may 
wish to disable these functions. Tool Tips can be disabled in the System Parameters module; Help 
Messages are disabled in the Options menu.



Document Filename

The Calamus document window displays document and layout areas. When you create a new document, 
it is automatically named NONAME1.CDK. The first time you save your document, you must enter a 
different filename by using the Save Document As... item in the File menu.



Document Information

You may also save more descriptive information about a document by double-clicking the title bar for the 
document window. The Document Information dialog box will appear:

The filename and path are shown in the top line. A descriptive title and project name may be added in the 
second and third lines. The original author's name is shown in the Creator field while the remaining lines 
show the Creation Date, Last Modified date and the name of the user who last modified and saved the 
document.



Master Page Mode

The document window can also display the master page associated
with any page by clicking the Master Page icon in the Toolbar. The example below is the master page for 
this part of the StartUp guidebook:

You can specify layout marks such as crop marks, registration marks, color plane names, etc. in the Page 
Layout Settings function of the Page module. To see layout marks in master page mode, you must first 
select the Layout button in the Options section of the Printer Settings dialog box.

See the Page Layout Settings in the Page section of chapter 5 for more information about layout marks. 
See Printer Settings in chapter 3 for more information about the Options dialog box.



Mouse Pointers

Calamus uses a variety of mouse pointers according to the task at
hand. Following is a glossary of the mouse pointers.

Arrow normal mouse pointer shape
Cross Hair draw or resize a frame in frame mode; select a text ruler in rule mode
Finger used to select or deselect frame or frame handle
Hand used in frame mode to move a frame
Ibeam used in text mode to enter or mark text
LShape used to kern text horizontally and vertically
Long Cross Hair used in frame mode to align elements with page rulers 
Magnifying Glass used to define an area to be magnified.
Page or Piping indicates that text is being formatted into frame or an arrow appears in 

frame mode to pipe text from one frame to another.
Printer appears as the program begins printing,



Selectors

Calamus uses the standard Windows NT file selector. You may also use the customized Calamus file 
selector by choosing it in the System Parameters module. In addition, Calamus for Windows NT uses an 
internal object selector for choosing modules, fonts, text styles, color lists, master pages and 
import/export drivers.



Print/Printer Settings Dialog Box



Calamus File Selector



Set Columns and Rows Dialog Box



Import Text Dialog Box



Calamus Text Editor Dialog Box



Print Document Dialog Box



Set Grid, Layout Ruler and Magnetic Frames Dialog Box



Load Font Dialog Box



Text Style List Parameters Dialog Box



Convert to Bitmap Frame Dialog Box



Send Editor Text into Text Frame Dialog Box



Calamus Installer Dialog Box



Calamus Logo Screen



Save Systems Settings Dialog Box



Set System Parameters Dialog Box



Calamus Desktop



Key Bindings Dialog Box



Ruler Settings Dialog Box



Select Style Dialog Box



Edit Text Style Dialog Box



Frame Data

Text

Raster Graphic

Line

Vector Graphic

Raster Area

Uniframe

 




